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Notes, Cautions and Warnings

For the protection of your product, and in order to ensure that you benefit from its full 
functionality, this model has been designed to operate only with genuine original toner 
cartridges. Any other toner cartridge may not operate at all, even if it is described as 
“compatible”, and if it does work, your product's performance and print quality may be 
degraded.

Specifications subject to change without notice. All trademarks acknowledged.

Note
A note provides additional information to supplement the main text. 

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
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Introduction
PRINTER FEATURES

• Memory: 64 MB 

• High speed printing: 30 ppm letter, 28 ppm A4

• Resolution: 2400 x 600 dpi 

• Paper handling: 530 sheets 20 lb. US Bond (75 g/m²)

• Emulation: standard Printer Control Language PCL6, Epson FX, and IBM ProPrinter

• Barcodes: embedded for SIDM emulations.

• Flash DIMM: 5 MB,  to allow the storage of additional fonts or bar codes.

• USB 2.0 High speed and Parallel interfaces. 

• 10/100 BASE-TX Network: lets you share this valuable resource among users on 
your office network.

• Multi Purpose tray to extend the range of media your printer can accommodate 
(capacity 50 sheets 20 lb US Bond [75 g/m²] or 10 envelopes), and can also be used 
for manual duplexing.

• Power save mode for energy efficiency.

Additionally, the following optional features are also available:

• Additional RAM DIMM: to extend the main memory of your printer and speed up the 
processing of large files.

• Second paper tray: to increase your printer’s paper handling capacity by 530 sheets 
of 20 lb. (75 g/m²) paper.



Printer Components
FRONT VIEW 

1 Operator panel

2 Output Stacker (150 sheets, face down)

3 Output Stacker extension

4 Top cover release button

5 Multi Purpose tray (show in open position): takes 50 sheets of 20-lb US Bond (75 
g/m2) paper

6 Multi Purpose Tray extension

7 Paper Tray: takes 530 sheets 

8 Paper Tray level indicator

9 ON/OFF switch

10 Rear Output cover
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BACK VIEW

11 Power cable connection

12 Duplex unit 

13 Parallel interface connection

14 USB interface connection

15 LAN interface connection (only for Xxxxxdn)

16 Test button (only for Xxxxxdn)

17 Memory panel (to upgrade your printer’s memory RAM DIMM)
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The Printer Operator Panel
The operator panel consists of an LCD display, a menu-driven control panel and two LED 
indicators. 

PANEL ELEMENTS

1 Liquid crystal display (LCD) panel 
• Two rows of up to 16 alphanumeric digits.
• Displays print status, menu items in menu mode and error messages. 

2 Menu Scroll Buttons. 
• Press and release to enter the Menu mode. 
• Press and release again to select the next menu.
• Press and hold for more than 2 seconds to scroll through the different menus.

3 Back button 
Press and release to return to the previous higher level menu item or to exit the 
menu.

4 Enter button
With the printer offline or online, press and release to place the printer n the Menu 
mode, indicated on the display.

5 Online button 
• In print mode, press to switch between ONLINE and OFFLINE status.
• In Menu mode, press to exit the menu and display ONLINE.  

6 Cancel button
• When printing press to cancel a print job. 
• In the Menu mode, press to exit the MENU mode and go ONLINE. 

Note
When  DATA appears on the display, press and hold the Enter button for 
five seconds to force the printer to print out the remaining data in the 
printer.

Note
When pressed in Menu mode, the Online button returns the printer to 
ONLINE status. Also when there is an error indicating wrong paper size, 
pressing the Online button forces the printer to print.
The Printer Operator Panel > 9



7 Ready indicator (green). 
• ON indicates ready to receive data. 
• FLASHING indicates processing data. 
• OFF indicates Offline. 

8 Attention indicator (red). 
• ON indicates a warning (e.g. low toner). 
• FLASHING indicates an error, (e.g. toner empty). 
• OFF indicates normal condition.

CHANGING THE OPERATOR PANEL LANGUAGE

The default language used by your printer for display messages and for report printing 
is English. If required, this can be changed to:

• Canadian French

• Latin American Spanish

• Brazilian Portuguese

Notes
The Operator Panel Language Setup Wizard will run automatically when 
you install the printer driver. Follow the instructions provided by this 
utility to set your chosen language.
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Menu functions
The Printer Menu allows you to view and change the printer’s internal settings.

The settings are grouped into categories or “menus” such as Information Menu or Print 
Menu.

Some of these settings are similar to those found in your printer driver or application 
software. The settings that you can change using this software act as the printer’s 
defaults. These can be overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer Menu settings to one, 
this will be overridden if you select three copies of your document in the printer driver.

Factory default settings are shown in the following tables.

INFORMATION MENU 

SHUTDOWN MENU

This menu shuts down the printer.

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE

NETWORK EXECUTE

PRINT FILE LIST EXECUTE

PRINT PCL FONT EXECUTE

PRINT PSE FONT EXECUTE

PRINT PPR FONT EXECUTE

PRINT FX FONT EXECUTE

DEMO 1 EXECUTE

PRINT ERROR LOG EXECUTE

USAGE REPORT EXECUTE Displayed only when ‘USAGE REPORT’ is 
enabled in the Print Statistics Menu

ITEM ACTION REMARKS

SHUTDOWN START EXECUTE
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PRINT MENUM 

MEDIA MENU 

ITEM DEFAULT REMARKS

COPIES 1

DUPLEX OFF

PAPER FEED TRAY1

AUTO TRAY SWITCH ON

TRAY SEQUENCE DOWN

MP TRAY USAGE DO NOT USE

MEDIA CHECK ENABLE

RESOLUTION 1200DPI

TONER SAVE MODE DISABLE

ORIENTATION PORTRAIT

LINES PER PAGE 64 LINES

EDIT SIZE CASSETTE SIZE

ITEM DEFAULT REMARKS

TRAY 1 PAPERSIZE A4

TRAY 1 MEDIATYPE PLAIN

TRAY 1 
MEDIAWEIGHT

MEDIUM

TRAY2 PAPERSIZE A4 When tray 2 is 
installed

TRAY2 MEDIATYPE PLAIN When tray 2 is 
installed

TRAY2 
MEDIAWEIGHT

MEDIUM When tray 2 is 
installed

MPT PAPERSIZE A4

MPT MEDIATYPE PLAIN

MPT MEDIAWEIGHT MEDIUM

UNIT OF MEASURE MILLIMETER

X DIMENSION 210 MILLIMETER

Y DIMENSION 297 MILLIMETER
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SYSTEM CONFIGURATION MENU 

PCL EMULATION 

ITEM DEFAULT REMARKS

POW SAVE TIME 1 MIN

PERSONALITY AUTO EMULATION

PARA PS-PROTOCOL ASCII

USB PS-PROTOCOL RAW

CLRABLE WARNING ONLINE

AUTO CONTINUE OFF

MANUAL TIMEOUT 60 SEC

TIMEOUT INJOB 40 SEC

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC

LOW TONER CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

START UP OFF

ITEM DEFAULT REMARKS

FONT SOURCE RESIDENT

FONT NO. I0

FONT PITCH 10.00 CPI

SYMBOL SET PC-8

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

TRAY ID#
PCL T0ID 4

PCL T1ID 1

PCL T2ID 5 When Tray2 is 
installed
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PPR EMULATION 

FX EMULATION 

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

FONT CONDENSE 12 CPI to 20 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

LINE LENGTH 80 COLUMN

FORM LENGTH 11.7 INCH 

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN

FORM LENGTH 11.7 INCH

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME
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PARALLEL MENU  

USB MENU 

ITEM DEFAULT REMARKS

PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME DISABLE

OFFLINE RECEIVE DISABLE

ITEM DEFAULT REMARKS

USB ENABLE

SOFT RESET DISABLE

SPEED 480Mbps

OFFLINE RECEIVE DISABLE

SERIAL NUMBER ENABLE
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NETWORK MENU 

PRINT STATISTICS MENU

This menu provides information on the number of letter/A4 pages printed and allows 
you to reset the counter. 

ITEM DEFAULT REMARKS

TCP/IP ENABLE

IP VERSION IPv4

NETBEUI ENABLE

NETWARE ENABLE

ETHERTALK ENABLE

FRAMETYPE AUTO

IP ADDRESS SET AUTO

IP ADDRESS xxx.xxx.xxx.xxx

SUBNET MASK xxx.xxx.xxx.xxx

GATEWAY ADDRESS xxx.xxx.xxx.xxx

WEB ENABLE

TELNET DISABLE

FTP DISABLE

SNMP ENABLE

NETWORK SCALE NORMAL

HUB LINK SETTING AUTO NEGOTIATE

FACTORY DEFAULTS EXECUTE

ITEM DEFAULT REMARKS

USAGE REPORT ENABLE

RESET COUNTER EXECUTE

GROUP COUNTER DISABLE

CHANGE PASSWORD Enter the new password.
Menu functions > 16



MAINTENANCE MENU

This menu provides access to various printer maintenance functions.

USAGE MENU

This menu is for information only, and provides an indication of total usage of the 
printer and the expected life left in its consumable items. This is particularly useful if 
you do not have a full set of replacement consumables to hand and you need to know 
how soon you will need them.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE

SAVE MENU EXECUTE

POWER SAVE ENABLE

PAPER BLACK SET 0

DARKNESS 0

CLEANING EXECUTE

RESTORE MENU EXECUTE Displayed in Menu when Menu settings have 
been stored.

ITEM DEFAULT REMARKS

DRUM LIFE REMAINING% An indication of the remaining drum life.

TONER REMAINING% An indication of how much toner is left in the 
cartridge.
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Printing menu settings
(The Menu Map)

Current menu settings can be confirmed by printing a Menu Map, using the control 
panel.

1 Press the up or down arrow button until INFORMATION MENU appears on the display, 
then press the Enter button.

2 Press the up or down arrow button until the display prompts you to print the menu 
map.

3 Press the Enter button to print the menu map. 

4 Press the Cancel, Online or Back button repeatedly to exit the MENU mode. 
Printing menu settings (The Menu Map) > 18



Paper Recommendations
For guidance on the media you can use with your printer, which input tray and which exit 
path to use, see the section entitled “Paper and tray information” in the “Specifications” 
chapter.

PAPER AND ENVELOPE TYPES

Recommended guidelines when selecting paper and envelopes for use in your printer:

• Paper and envelopes should be stored flat and away from moisture, direct sunlight and 
heat sources.

• Use a smooth finished paper such as copier or laser type paper with a Sheffield 
(smoothness) rating of 250 or less. If in doubt, please ask your paper supplier.

• Use paper and envelopes that are designed for use in laser type printers.

• The use of heavily laid or textured paper will seriously impact on the life of the image 
drum.

• Do not use very smooth, shiny/glossy paper.

• Do not use heavily embossed headed paper.

• Do not use specially treated papers such as carbon paper, non-carbon paper, thermal 
paper and impact paper.

• Avoid using paper with perforations, cut-outs and ragged edges.

• Do not use envelopes with windows or metal clasps.

• Do not use envelopes with self sealing flaps.

• Avoid using damaged or curled envelopes.

TRANSPARENCIES AND ADHESIVE LABELS

Recommended guidelines when selecting transparencies and adhesive labels for use in your 
printer:

• Always manually feed single sheets using the Multi Purpose Tray.

• Always use rear output.

• Media must be designed for use in laser printers or photocopiers and must be able to 
withstand 392°F (200°C) for 0.1 sec. 

• Do not use media designed for use in color laser printers and photocopiers. 

• Labels should cover entire carrier sheet.

• Carrier sheet or adhesive must not be exposed to any part of the printer.
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POSTCARDS

Recommended guidelines when selecting postcards for use in your printer:

• Always manually feed single postcards using the Multi Puprose Tray.

• Use unfolded double postcards.

• Use postcards designed for use in laser type printers

• Do not use postcards used for ink jet printers.

• Do not use stamped or picture postcards.
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Loading Tray 1 and Optional Tray 2 

1. Remove the paper tray from the bottom of the printer and place plain paper (1) in 
the tray, keeping the level of the paper in the tray below the paper full guide 
arrowheads shown on the paper guides (2). For loading A4 or Legal size paper, push 
the lever (4) in the arrow direction and extend the paper tray using the rear paper 
support (5). 

 

Note
If you are topping off the paper in a paper tray, it is recommended that you 
remove the remaining paper from the tray first, then add the new paper 
stock and place the paper you removed on top. This ensures that the oldest 
paper is used first to help prevent paper jams.

Note
Load letterhead paper face down and top edge towards the front of the 
paper tray (3).
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2. Adjust the rear paper support (5) to the size of paper you are using by gripping the 
lugs, tilting and sliding the support forward or backward as necessary.

3. Adjust the side paper guides (6). It is important to adjust the paper guides (5) 
correctly to ensure that the paper is not skewed in the print process. Paper jams 
may occur if this operation is not carried out correctly.

4. Replace the tray in the printer (7). The external paper level indicator (8) provides a 
visual indication of how much paper is left in the tray.

Configure the media size and media weight for the respective trays in the operator panel.

Note
If you have the optional second paper tray (Tray 2) and you are printing 
from the first (upper) tray (Tray 1), you can pull out the second (lower) tray 
to reload it. However, if printing from the second (lower) tray, do not pull 
out the first (upper) tray as this will result in a paper jam.
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Loadimg the Multi Purpose Tray

1. Open the Multi Puropse Tray:

(a) Pull down the tray (1).

(b) Flip out the inner support section (2).

(c) swing out the paper support (3).

(d) Adjust the paper guides (4) to the width of the print media.

2. Load the paper into the Multi Purpose Tray and push the set button. 

Note
Always use the rear exit path (straight through feed) with the Multi Purpose 
Tray.
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3. Ensure that the paper is loaded below the arrow level to avoid paper jam.  

Media Loading Tips

• For single-sided printing on headed paper load the paper with the pre-printed side 
up and top edge into the printer.

• For two-sided (duplex) printing on letterhead paper, load the paper with the pre-
printed side down and top edge away from the printer.

• Envelopes should be loaded flap down, face up with the top edge to the left and 
short edge into the printer.

• Load Transparencies face up and top edge into the printer.

4. If required, set the media size and orientation in the media menu using the control 
panel, then issue the print command. 

Note
Do not exceed the paper capacity of approximately 50 sheets or 10 
envelopes depending on the media weight.

Note
Do not select Duplex printing on envelopes.

CAUTION!

Damage to the printer may occur if the incorrect paper setting is 
used when printing on a different media.

Notes
• You can also set the media type in your printer driver. However, the 

printer driver settings will override the settings on the control panel.

• Remember to reset the printer for normal paper after printing on a 
different media.
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Paper feed, size and media setting
The process used to fuse (fix) the printed image to the paper involves a mixture of pressure 
and heat. Too much heat will cause lightweight paper to crease or curl and corrugations in 
transparencies. Too little heat will cause the image not to fuse fully into heavyweight paper.

Using the control panel on your printer, you can choose

• which paper to use

• the paper size

• the paper weight (thickness)

• the type of paper

PAPER FEED SELECTION

The paper feed, paper size, paper weight and media type can be set manually on the printer 
using the control panel as follows.

1. Press the up or down arrow button repeatedly until PRINT MENU displays, then press 
the Enter button.

2. Press the up or down arrow button repeatedy until the required paper feed displays.

3. Press the Enter button. 
An asterisk (*) appears next to the selected paper feed.

Note
Although media properties can be set in the printer driver for particular jobs, 
when filling a tray with media it is recommended that you manually set the 
printer to match the media as described here.

Note
• If the settings in the printer differ from those selected on your 

computer, the printer will not print and the LCD will display an error 
message.

• The following printer settings are given as a guide only. Some software 
applications require the paper feed, size and media settings to be 
selected from within the application (page setup).

• Although media properties can be set in the printer driver for particular 
jobs, it is recommended that when filling a tray with media you 
manually set the printer menu to match the media as described here.
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4. Press the Cancel, Online or Back button repeatedly to exit the MENU mode.

PAPER SIZE

Set the paper size as follows. 

1. Press the up or down arrow button until PRINT MENU displays, then press the Enter 
buttos

2. Press either the up or down  button repeatedly until EDIT SIZE displays, then press 
the Enter button.

3. Press either the up or down  button until the required paper size displays, then press 
the Enter  button. 
An asterisk (*) appears next to the selected paper size.

4. Press the Cancel, Online or the Back button repeatedly to exit the MENU mode.

5. Select the correct paper settings in the printer driver before printing the file.

Note
When the AUTO TRAY SWITCH is set to ON and more than one paper tray is 
fitted, paper feed automatically switches to the next available paper tray, 
providing non-stop printing.

Note
• When using paper trays, standard paper sizes are recognized 

automatically with CASSETTE SIZE (default setting) selected. Paper size 
need only be set for custom paper sizes.

• When using the Multi Purpose Tray, the paper size has to be selected.
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MEDIA TYPE AND WEIGHT

Set media type and weight as follows: 

 

1. Press the up or down arrow button until MEDIA MENU displays, then press the Enter  
button.

2. Press the up or down arrow button until MEDIA TYPE or MEDIA WEIGHT for the 
required tray is displayed, then press the Enter button.

3. Press the up or down arrow button until the required paper type or weight is 
displayed, then press the Enter button. 
An asterisk (*) appears next to the selected paper type or weight.

4. Press the Cancel, Online or the Back button repeatedly to exit the MENU mode.

5. Select the correct paper settings in the printer driver before printing the file.

CAUTION!

If media type or media weight are not correctly set, print quality 
deteriorates and the fuser roller may be damaged.
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Selecting a Paper Exit Path
FACE DOWN  PRINTING (TOP EXIT PATH)
For face down printing, make sure the Rear cover is closed (the paper exits from the top 
of the printer). 

• The Output Stacker on the top of the printer stacks printed pages face down.

• Capacity 150 sheets of 20-lb US Bond (75 /m²). 

• Pages are printed in reading order (page 1 first) will be sorted in reading order (last 
page on top, facing down).

FACE UP PRINTING (STRAIGHT THRPUGH, REAR EXIT PATH)
For a straiht-throuh paper path rerquired for heavy paper, envelopes, transparencies, etc., 
make sure the rear exit is open. With the rear exit open, paper will exit via this path, 
regardless of driver settings. 

Always use this tray in conjunction with the Multi Purpose Tray or for heavyweight stocks 
to reduce the possibility of paper jams. 

• The rear exit stacker stacks printed pages face up.

• Capacity 150 sheets of 20-lb US Bond (75 /m²). 

• Pages are printed in reverse reading order (lasd page first) will be sorted in reverse 
reading order (first page on top, facing down).

See “Paper and tray information” on page 71.
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Automatic feed sequence
With no optional feed trays installed, the Autotray function in the Print Menu is set by 
default to ON and the Tray sequence function is set to DOWN. In this way, if a tray runs 
out of paper, automatic feed will take place in the order Tray 1, Tray 2 (if fitted), Multi 
Purpose Tray, provided that these trays are set up for identical media. Also, co
Automatic feed sequence > 29



Interfaces > 30

Interfaces
Your printer is equipped with a selection of data interfaces:

1. Parallel – For direct connection to a PC. This port requires a bi-directional (IEEE 
1284 compliant) parallel cable.

2. USB – For connection to a PC running Windows 2000 or later or Mac OS X or later. 
This port requires a cable conforming to USB version 2.0 or above.

The operation of a printer is not assured if a USB compatible device is connected 
concurrently with other USB-compatible machines.

When connecting multiple printers of the same type, they appear as *****, ***** 
(2), ***** (3), etc. These numbers depend on the order of connecting or turning on 
each printer.

3. LAN – For network cable connection. 

If you are connecting your printer directly to a stand alone computer proceed to the chapter 
entitled “Printer Drivers”.

If your printer is to be installed as a network printer, please refer to the relevant section in 
the User’s Guide for the network interface card for further details on how to configure the 
network connection before installing the printer drivers.

Note
• It is not recommended that you connect serial/USB and parallel cables to 

the printer simultaneously.

• Interface cables are not supplied with your printer.

Note
Administrator’s authority is required when installing a network connection.
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Printer Drivers
This chapter describes how to install a printer driver on two types of operating system 
– Windows and Macintosh.

The printer drivers are all contained on the printer driver CD-ROM (CD1). Please refer 
to the readme file on this CD for the latest information on printer driver installation.

WINDOWS OPERATING SYSTEMS

1. With Windows running, insert the printer driver CD-ROM (CD1) in your CD-ROM 
drive.

2. If the CD does not run automatically, use Start > Run... and enter E:\setup 
(where E is your CD-ROM drive) in the Open field.

3. Click OK.

4. Select your printer model.

5. Click on Driver Installation > Install Printer Driver and follow the on-screen 
prompts to complete your printer driver installation.

6. Once the driver has been installed, the operator panel language switching utility 
will run automatically. Choose your preferred operating language. See “Changing the 
Operator Panel language” on page 10.

INSTALLED OPTIONS

Certain options may have been installed in your printer. For those that are installed, 
check that they appear enabled on the Menu Map. 

Ensure that your options are set up in the printer driver(s) by making the appropriate 
settings on the Device Options tab (PCL emulation) described in the chapter entitled 
“Operation”.

MACINTOSH OPERATING SYSTEMS

Please refer to the readme file on the CD for details on installing the appropriate 
Macintosh drivers.

INSTALLED OPTIONS

Ensure that any installed options are enabled in the printer driver.

CHOOSING A MAC DRIVER

You can use only the PCL Mac driver. 

Note
Take time to note the facilities available on the CD. For example, the Help 
facility briefly describes each of the Software Utilities.



Operation
This chapter provides a broad outline of how to operate your printer in the PCL 
emulation from either a Windows or a Macintosh environment. 

PRINTER SETTINGS IN WINDOWS

The operator panel controlled menus provide access to many options.

The Windows printer driver also contains settings for many of these items. Where items 
in the printer driver are the same as those in the operator panel, and you print 
documents from Windows, the settings in the Windows printer driver will override those 
settings in the operator panel.

PRINTING PREFERENCES IN WINDOWS APPLICATIONS

When you choose to print your document from a Windows application program a Print 
dialog box appears. This dialog usually specifies the name of the printer on which you 
will print your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains a short list of the 
printer settings available in the driver, which you can choose for this document. The 
settings available from within your application are only those which you may want to 
change for specific applications or documents. Settings you change here will usually 
only last for as long as the particular application program is running.

The tabs available are the Setup Tab, the Job Options Tab and the Image Tab.

SETUP TAB

1. Paper size should be the same as the page size of your document (unless you 
wish to scale the printout to fit another size), and should also be the same as the 
size of paper you will feed into the printer.

Note   
The illustrations in this guide relate to Windows XP PCL  emulation – 
other operating system windows may appear slightly different but the 
principles are the same.
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2. You can choose the source of the paper to feed, which may be Tray 1 (the 
standard paper tray), Tray 2 (if you have the optional second paper tray 
installed) or the Multi Purpose Tray. You can also click on the appropriate part of 
the screen graphic to select your preferred tray.

3. A variety of document finishing options can be selected, such as normal one page 
per sheet, or N-up (where N can be 2 or 4) for printing scaled down pages at 
more than one page per sheet.

4. Under 2-sided Printing, you can choose from auto or manual. Under manual 
2-sided Printing you can choose to print on one side of a sheet only or to use 
2-sided printing (duplex printing). Your printer allows you to carry out manual 
duplex printing, meaning you must pass the paper through the printer twice. For 
more information, see “2-Sided (Duplex) Printing” on page 39. The Duplex Help 
button also offers guidelines on how to carry out manual duplex printing.

5. If you have changed some printing preferences before and saved them as a set, 
you can recall them to avoid having to set them individually each time you need 
them.

6. A single on-screen button restores the default settings.

JOB OPTIONS TAB

1. The output resolution of the printed page can be set as follows.

• The High Quality setting prints at 1200 x 1200 dpi and is the best option for 
printing vector objects such as graphics and text. 

• The Normal setting prints at 600 x 600 dpi and is suitable for most printing 
jobs.

• The Draft setting prints at 300 x 300 dpi and is suitable for printing draft 
documents that contain mainly text. You can select Toner Saving to save toner 
for some print jobs.

2. Page orientation can be set to either portrait (tall) or landscape (wide).  

3. You can print watermark text behind the main page image. This is useful for 
marking documents as draft, confidential, etc.

4. In Raster (bitmap) mode, processing of the page image is done in the computer 
leaving little processing for the printer to do, although the file size may be large. 
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In Vector mode, file sizes may be smaller and so transmission over a network, for 
example, may be faster. These effects are more pronounced for graphics printing 
than for text printing.

5. You can select up to 999 copies to print consecutively, although you will need to 
top up the paper tray during such a long print run.

6. Your printed pages can be scaled to fit larger or smaller stationery, within a 
range of 25% to 400% of the original size.

7. A single on-screen button restores the default settings.

IMAGE TAB

1. Dithering produces an intermediate greyscale. Selecting a setting determines the 
degree of detail with which a graphics image will be printed. Select Mesh to use a 
screen of dots for dithering. Select Line Art to use an array of lines for dithering.

2. Select dithering texture by setting the size of dots used in the halftone screen.

3. Enables/disables printing greyscale effects in black without dithering.

4. You can manually adjust lightness (the higher the setting the lighter the print) 
and contrast (the higher the setting the greater the contrast).

5. A single on-screen button restores the default settings.

SETTING USING THE WINDOWS CONTROL PANEL

When you open the driver properties window directly from Windows, rather than from 
within an application program, a somewhat more extensive range of settings is 
provided. Changes made here will generally affect all documents you print from 
Windows applications, and will be remembered from one Windows session to the next.

The main tabs are the General Tab, Advanced Tab and Device Options Tab.
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GENERAL TAB

1. This area lists some of the main features of your printer, including optional items.

2. This button opens the same windows as described earlier for items which can be 
set from within application programs. Changes you make here, however, will 
become the new default settings for all Windows applications.

3. This button prints a test page to ensure that your printer is working.

ADVANCED TAB

1. You can specify which times of day your printer will be available.

2. Indicates current priority, from 1 (lowest) to 99 (highest). Highest priority 
documents will print first.

Note
The above features are provided by the Windows XP operating system 
and will vary with other operating systems.

1

2 3

My Printer Properties

1

2

3

4

5

6

7

8

9 10

My Printer Properties
Operation > 35



3. Specifies that documents should be spooled (stored in a special print file) before 
being printed. The document is then printed in the background, allowing your 
application program to become available more quickly. Options follow:

This specifies that printing should not start until the last page has been spooled. 
If your application program needs a lot of time for further computation in the 
middle of printing, causing the print job to pause for more than a short period, the 
printer could prematurely assume that the document has finished. Selecting this 
option would prevent that situation, but printing will be completed a little later, as 
the start is delayed.

This is the opposite choice to the one above. Printing starts as soon as possible 
after the document begins spooling.

4. This specifies that the document should not be spooled, but printed directly. Your 
application will not normally be ready for further use until the print job is 
complete. This requires less disk space on your computer, since there is no spool 
file.

5. Directs the spooler to check the document setup and match it to the printer setup 
before sending the document to print. If a mismatch is detected, the document is 
held in the print queue and does not print until the printer setup is changed and 
the document restarted from the print queue. Mismatched documents in the 
queue will not prevent correctly matched documents from printing.

6. Specifies that the spooler should favour documents which have completed 
spooling when deciding which document to print next, even if completed 
documents are lower priority than documents which are still spooling. If no 
documents have completed spooling, the spooler will favour larger spooling 
documents over shorter ones. Use this option if you want to maximize printer 
efficiency. When this option is disabled the spooler chooses documents based 
only on their priority settings.

7. Specifies that the spooler should not delete documents after they are completed. 
This allows documents to be re submitted to the printer from the spooler instead 
of printing again from the application program. If you use this option frequently it 
will require large amounts of disk space on your computer.

8. Specifies whether advanced features, such as pages per sheet, are available, 
depending on your printer. For normal printing keep this option enabled. If 
compatibility problems occur you can disable the feature. However, these 
advanced options may then not be available, even though the hardware might 
support them.

9. This button provides access to the same setup windows as when printing from 
applications. Changes made via the Windows Control Panel become the Windows 
default settings.

10. You can design and specify a separator page that prints between documents. 
This is particularly useful on a shared printer to help each user find their own 
documents in the output stack.

Note
The above features are provided by the Windows XP operating system 
and will vary with other operating systems.
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DEVICE OPTIONS TAB

In this window you can select which optional upgrades are installed on your printer. See 
the chapter entitled “Installing options”.

PRINTER SETTINGS IN MACINTOSH

Refer to the readme file on the driver CD and the online help provided in the driver 
software.
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POWER SAVE MODE

Power Saving sets how long the printer waits before going into standby mode. In 
standby mode your printer’s energy consumption is reduced. You can specify the length 
of time before a printer enters power saving mode by setting a larger value.

CHANGING THE LENGTH OF TIME BEFORE ENTERING POWER SAVE MODE

1. Press the up or down arrow  button until System Configuration Menu appears. 
Press the Enter button.

2. Press the up or down arrow  button until Power Save Time appears. Press the 
Enter button.

3. Press the up or down arrow  button until the desired setting appears. Press the 
Enter button.
 An asterisk (*) will appear to confirm the selection.

4. Press Online.

DISABLING POWER SAVE MODE

1. Press the up or down arrow  button until Maintenance Menu appears. Press the 
Enter button.

2. Press the up or down arrow  button until Power Save appears. Press the Enter 
button.

3. Press the up or down arrow  button until Disable appears. Press the Enter 
button.
An asterisk (*) will appear to confirm the selection.

4. Press Online.

Note
The printer’s Power Save mode default setting is Enabled, 1 minute.
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2-Sided (Duplex) Printing 
The duplex unit adds the function of two-sided printing, using less paper and making large 
documents easier to handle. It also enables booklet printing, which uses even less paper.

This printer has the option of Auto Duplex and Manual Duplex printing.

AUTO DUPLEX PRINTING

This option provides automatic two-sided printing only for Letter, A4, Legal 13 and 14 and 
Custom paper sizes, using paper stocks from 16 - 28 lb. US Bond (60 - 105 g/m2). 

To carry out Auto Duplex Printing:

1. Select File -> Print and click the Properties button. 

2. Select the input tray: Tray1 (or optional Tray2) or Multi Purpose Tray from the 
Source drop down.

3. In the 2-Sided Printing drop down menu, select either Long Edge (Auto) or 
Short Edge (Auto) according to your printing preferences. 

4. Click OK.

Note
The steps in the process relate to Windows XP PCL. Other operating system 
windows may appear slightly different, but the principles are the same.

Note
For  Letter, Legal 13 and 14, Statement, Executive, A4, A5, A6, B5, and 
Custom paper sizes, see Manual Duplex Printing on page 42.

Note
For further information, click the Duplex Help button.
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MANUAL DUPLEX PRINTING USING THE PAPER TRAY 
(WINDOWS ONLY) 

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the printer 
twice.

1. Ensure that there is enough paper in the Paper Tray to carry out the print job. 

2. Select File > Print and click the Properties button. 

3. Select Tray1 from the Source drop down.

4. In the 2-Sided Printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. Click OK. 
For further information, click the Duplex Help button. 

5. Then, click OK. 

6. Every second page (1) of your document is printed first. 

7. When this is complete, a message appears on the display panel prompting you to 
take the paper, flip it and replace it in the Paper Tray. 

8. Open the Paper Tray (2). Take the printed paper from the Output Stacker (3) and 
place it in the Paper Tray, ensuring that the printed side is facing up and the bottom 
of the page facing into the printer (4). 

Note
Manual Duplex printing is available only for the Windows PCL Driver. 

You cannot use A6 paper size for printing from Tray 1 or optional Tray 2.
2-Sided (Duplex) Printing > 40



9. Close the Paper Tray and press the Online button. The message window should 
disappear from your screen and the printer finishes printing the remaining pages of 
your document. 

Note
You must press the Online button to start the printing for the other side. The 
default time is set to one minute, failing which, the data is deleted and not 
printed.
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MANUAL DUPLEX PRINTING USING THE MULTI-PURPOSE TRAY 

1. Position the paper guides on the Multi-Purpose Tray according to the paper size.

2. Place up to 50 sheets of paper in the Multi-Purpose Tray. 

3. Select File -> Print to display the Print dialogg box.

4. Click the Properties button. 

5. Select Multi-Purpose Tray from the Source drop down.

6. On the 2-sided printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. Click OK.
When every second page has printed, take the paper from the output stacker.

7. Set the stack of paper in the Multi-Purpose Feeder

8.  with the printed side facing down and the top of the page facing into the printer. 
Ensure that the paper is gripped in place.

LONG EDGE.

Note
You can print. Letter, Legal 13 and 14, Statement, Executive, A4, A5, A6, 
B5, and Custom paper sizes, using paper stocks from 16 to 32 lb. US Bond 
(60 - 124 g/m2).
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SHORT EDGE.

9. Press the Online button. The remaining page(s) of your document print on the 
blank side of the stack of pages from the Multi-Purpose Feeder. 
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Overlays and Macros (Windows Only)
WHAT ARE OVERLAYS AND MACROS?
If you would like to print on special stationery, such as forms and letterhead, but do not 
want to use pre-printed stationery, you can create your own using these advanced 
features.

You can create several overlays or macros, and combine them in any way you like to 
produce a variety of forms and other special stationery. Each image can be printed on 
just the first page of a document, on all pages, on alternate pages, or just the pages 
that you specify.

CREATING PCL OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer 
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on the CD included with 
your printer to create a “project file,” import the .PRN file, and download the 
generated filter (.BIN) files to the printer.

3. Use downloaded files to define your overlay ready for use with any future 
document.

When printing files to disk, do not select any special features, such as two-sided 
printing or multiple copies. These are not appropriate to macros, they apply only 
to your final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the 
required image and save it.

2. Open your application’s Print… dialog.

3. Make sure that the selected printer name (1) is that 
of your PCL printer driver.

4. Select the Print To File (2) option.

5. When prompted for a print file name, enter a 
meaningful name with the extension .PRN .

6. Close your application.

CREATE AND DOWNLOAD MACROS

1. From the Windows Start menu, open Storage Device Manager (SDM) and 
allow SDM to discover the printer.

2. Choose Projects  > New Project.

3. Choose Projects > Filter Macro File. The Filter Printer Patterns dialog box 
appears. Make any adjustments in the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave all the color command 
filters checked, the black oval will print as a black rectangle when the overlay is 
used. To maintain the oval shape, turn off (deselect) the “Configure Image Data,” 
“Palette ID” and “Palette Control” filters.
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4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the overlay .PRN files are stored and select one or 
more of these to include in your overlay set.

You can have more than one macro file in a project. For example, one for top 
pages and another for continuation pages. Use standard Windows techniques 
(Shift or Ctrl keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project. (You can also drag and drop 
files from Windows Explorer directly into the project window if you prefer.) When 
a message box appears confirming that a filter file has been created, click OK to 
clear the message.

7. The project window will display one .BIN file for each printer file added. Make a 
careful note of the name and ID number for each of the files. You will need them 
later.

If you wish to edit the names or ID numbers, double-click the file entry and edit 
the details. 

Note that the names are case sensitive. 

8. Choose Projects > Save Project and enter a meaningful name (e.g. “Letter 
Stationery”) so that you can recognize it.

9. Choose Projects > Send Project Files to Printer to download the project to the 
printer.

10. When the message “Command Issued” appears confirming that the download is 
complete, click OK to clear the message.

TEST PRINTING THE MACRO

1. Choose Printers > Test Macro.

2. In the Test Macro window, enter its ID number and click OK. After a short pause 
the printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects > Exit to close 
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the 
Start menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing 
Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click the Define Overlays 
button (1).

1
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5. In the Define Overlays window, enter the name (a) and 
ID (b) of the required overlay, and define which 
page(s) (c) of your documents will use this overlay. 
Then click the Add button (3) to add this overlay to the 
list of defined overlays. Repeat for any other related 
overlays. When done, click the Close button (4) to close 
the window.

The example illustrated shows two overlays defined, one 
for a cover page and one for continuation pages.

Remember that names and IDs of overlay files must be entered exactly as they 
appeared in the Storage Device Manager project window. Remember also that 
names are case sensitive.

If you forgot to note the overlay name or ID when you created them, you can find 
them using Storage Device Manager to view the project file, or the printer’s 
Information Menu to print a file list and identify them from there.

The new overlays will now appear in the Defined Overlays list in the printer 
properties window.

6. When done, click OK to close the printing preferences window.

Your new overlays are now ready and available to be used for any future documents 
you wish.

PRINTING WITH PCL OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you 
wish. The example illustrated here uses two overlays for business letters. The first 
prints on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. 
Remember, if necessary, to format the document so that it will fit nicely within 
the plain areas on your letterhead overlay.

2. Open your application’s Print… dialog and choose any options you will require, 
ensuring that the target printer is your PCL printer driver in which the overlays 
have been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Overlay tab, check the Use active overlays 
checkbox (1).

5. In the Defined Overlays list, click on the first 
overlay (2) you wish to use, and click the Add 
button (3) to add it to the Active Overlays list. (If you 
want a reminder of how this overlay looks, click the 
Test Print button.)

6. If you want to use another overlay with this document, 
in this example it is the “Continuation Page” overlay, 
click this overlay (4) in the list of defined overlays, and then click the Add 
button (3) again to add the second overlay to the list of active overlays.

7. When the list of active overlays contains all the items you want to use, click OK.

8. Finally, click the Print button in your application’s Print dialog to begin printing 
your document.

a

3

b

4

c

1

3

4

2
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Consumables and Maintenance
This section deals with the replacement of the toner cartridge and image drum and 
general maintenance.

TONER CARTRIDGE LIFE

How long your toner cartridge lasts depends on the print density; the percentage of the 
page that prints black. A typical letter has 3% to 5% print density; graphics usually 
have higher density. Higher print density means toner is used up faster. At 5% print 
density, a standard toner cartridge will print an average of 3500 pages. Remember, this 
is only an average:actual results may vary.

The first toner cartridge installed in a new printer has to fill the image drum reservoir 
and saturate the developing roller with toner. The toner cartridge that is supplied with 
this printer normally produces about 1,500 pages after installation.

WHEN TO REPLACE THE TONER CARTRIDGE

When the toner is running low, TONER LOW is displayed in the operator panel LCD. After 
Toner Low displays, the printer will print about 100 more pages then display Toner 
Empty and stop printing. Printing will resume after a new toner cartridge has been 
installed.

REPLACING THE TONER CARTRIDGE

It is recommended that you clean the LED array at the same time as you change the 
toner cartridge.

The toner used in this printer is a very fine dry powder contained in the toner cartridge.

Have a sheet of paper handy so that you have somewhere to place the used cartridge 
while you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the new one came in. 
Follow any regulations, recommendations, etc., which may be in force concerning waste 
recycling.

If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, 
damp cloth to remove any residue. Do not use hot water, and never use solvents of any 
kind. They will make stains permanent.

WARNING

• Never expose a toner cartridge to an open flame. It can cause 
an explosion and you can be burned.

• Be sure to switch off and unplug the machine before 
accessing the interior of the machine for cleaning, 
maintenance or fault clearance. Access to a live machine’s 
interior can cause electric shock.

WARNING!

If you inhale any toner or get it in your eyes, drink a little water 
or bathe your eyes liberally in cold water. Seek medical attention 
immediately.
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1. Switch off the printer and allow the fuser to cool for about 10 minutes before 
opening the top cover.

2. Press the top cover release button and open the printer’s top cover fully. 

3. Pull the colored lever (1) on the right side of the toner cartridge towards the front 
of the printer to close the cartridge then remove the used toner cartridge (2).

4. Clean the top of the ID unit with a clean, lint-free cloth.

5. Put the cartridge down gently onto a piece of paper to prevent toner from 
marking your furniture.

6. Remove the new cartridge from its box but leave its wrapping material in place 
for the moment.

WARNING!

If the printer has been powered on, the fuser may be hot. This 
area is clearly labelled. Do not touch.

1

2
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7. Gently shake the cartridge (3) from end to end several times to loosen and 
distribute the toner evenly inside the cartridge.

8. Remove the wrapping material and peel off the adhesive tape from the underside 
of the cartridge (4).

9. Holding the cartridge by its top center with the colored lever to the right (5), 
lower it into the printer over the image drum unit from which the old cartridge 
was removed.

10. Insert the left end of the cartridge into the image drum unit first. Align it under 
the tabs (6), and push it against the shiny pins in the drum unit. Then lower the 
right end of the cartridge down into the image drum unit (7).

4

3

5

6

7
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11. Pressing gently down on the cartridge to ensure that it is firmly seated, push the 
colored lever towards the rear of the printer (8). Push the lever all the way 
forward until the pointers on the drum and the toner are aligned (8a). This will 
lock the cartridge into place and release toner into the image drum unit.

12. Gently wipe the LED array surface (9) with a soft tissue.

13. Close the top cover and press it down to latch it closed.

8
8a

9
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IMAGE DRUM LIFE

The life of an image drum depends on a number of factors, including temperature and 
humidity, the type of paper used, and the number of pages per job.

The image drum should last approximately 25,000 pages continuous printing. This 
number is approximate because different numbers of pages are printed each time and 
the environmental conditions and the paper type used may vary.

WHEN TO REPLACE THE IMAGE DRUM

When the drum reaches 90% of its life, a CHANGE DRUM message is displayed in the 
operator panel LCD. Change the image drum when the print becomes faint or begins to 
deteriorate.

REPLACING THE IMAGE DRUM.

1. Press the cover release and open the printer’s top cover fully. 

WARNING

• Never expose the image drum to an open flame. It can cause 
an explosion and you can be burned.

• Be sure to switch off and unplug the machine before 
accessing the interior of a machine for cleaning, maintenance 
or fault clearance. Access to a live machine’s interior can 
cause electric shock.

Note
It is recommended that you change the toner cartridge and clean the LED 
array at the same time as you change the image drum.

WARNING!

If the printer has been powered on, the fuser may be hot. This 
area is clearly labelled. Do not touch.
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2. Holding it by its top centre, lift the used image drum and toner cartridge, out of 
the printer.

3. Put the assembly down gently onto a piece of paper to prevent toner from 
marking your furniture and to avoid damaging the green drum surface.

4. With the colored toner release lever to the right, pull the lever towards you. This 
will release the bond between the toner cartridge and the image drum unit.

5. Lift the right-hand end of the toner cartridge and then draw the cartridge to the 
right to release the left-hand end, and withdraw the toner cartridge out of the 
image drum cartridge. Place the cartridge on a piece of paper to avoid marking 
your furniture.

6. Take the new image drum cartridge out of its packaging and place it on the piece 
of paper where the old cartridge was placed. Keep it the same way round as the 
old unit. Pack the old cartridge inside the packaging material for disposal.

7. Place the toner cartridge onto the new image drum cartridge. Push the left end in 
first, and then lower the right end in. 

8. Push the colored release lever away from you to lock the toner cartridge onto the 
new image drum unit and release toner into it.

CAUTION!

The green image drum surface at the base of the ID unit is very 
delicate and light sensitive. Do not touch it and do not expose it 
to normal room light for more than 5 minutes. If the drum unit 
needs to be out of the printer for longer than this, please wrap 
the cartridge inside a black plastic bag to keep it away from 
light. Never expose the drum to direct sunlight or very bright 
room lighting. 

Note
Follow instructions that come with the new image drum for additional 
information such as the removal of packaging material etc.
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9. Holding the complete assembly by its top center, lower it into place in the printer 
locating the pegs (1 & 2) at each end into their slots in the sides of the printer 
cavity (3).

10. Gently wipe the LED array surface with a soft tissue.

3

1

2
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11. Close the top cover and press it down to latch it closed.

GENERATING A CLEANING PAGE

If the printed page shows signs of fading, streaking or erratic marks, the problem may 
be cleared by generating a drum cleaning page as follows.

1. Pull down the Multi Purpose Tray (1), fold out the paper support (2), and adjust 
the paper guides to the width of the paper (3).
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2. Insert a sheet of Letter/A4 plain paper between the paper guides and push the 
colored set button to engage the tray. 

3. Press the Up or down arrow button repeatedly until MAINTENANCE MENU displays, 
then press the Enter button.

4. Press the Up or down arrow button until CLEANING PRINT is displayed.

5. Press the Enter  button.

6. The printer grips the paper and prints a cleaning page. The printer should now be 
ON LINE. 

7. If subsequent printing appears faded or uneven, try replacing the toner 
cartridge.
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CLEANING THE LED ARRAY

Clean the LED array whenever a new toner cartridge is installed or if there are faded 
vertical areas or light printing down a page.

1. Press the cover release and open the printer’s top cover fully. 

2. Wipe the LED array gently with a soft tissue.

WARNING!

If the printer has been powered on, the fuser may be hot. This 
area is clearly labelled. Do not touch.
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3. Close the top cover and press it down to latch it closed.
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Troubleshooting
STATUS AND ERROR MESSAGES

The LCD on the printer operator panel provides the self-explanatory status and error 
messages in your chosen language. Error messages are accompanied by the Ready 
indicator going out.

PAPER JAMS

Provided that you follow the recommendations in this guide on use of print media, and 
you keep the media in good condition prior to use, your printer should give years of 
reliable service. However, paper jams occasionally do occur, and this section explains 
how to clear them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper 
path through the printer. When a jam occurs, the printer immediately stops, and the 
operator panel informs you of the event. If printing multiple pages (or copies), do not 
assume that having cleared an obvious sheet that others will not also be stopped 
somewhere along the path. These must also be removed in order to clear the jam fully 
and restore normal operation.

The printer may experience a paper jam in one of three areas. 

1. INPUT JAM - paper has failed to leave the selected feed tray and enter the 
internal paper path of the printer. A typical message indicates a paper jam and 
identifies the tray to check.

2. FEED JAM - paper has entered the printer but failed to reach the exit. A typical 
message indicates a paper jam and advises you to open the top cover for access.

3. EXIT JAM - paper has reached the exit but has failed to exit completely from the 
printer. A typical message indicates an exit jam and advises you to open the top 
cover for access.

1 2
3
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INPUT JAM

1. Remove the paper tray from the printer (1).

2. Remove any crumpled or folded paper.

3. Remove any paper from the underside of the printer (2).

4. Replace the paper tray. 

After successful removal of any damaged or misfed paper, the printer should continue 
printing.

FEED JAM OR EXIT JAM

1. Remove the tray and clear any misfed sheets as given above. 

1

2

1

2
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2. Press the cover release and open the printer’s top cover.

3. Carefully lift out the image drum, complete with the toner cartridge. Place the 
drum on a piece of paper  and cover it with a piece of paper to protect it from 
light. Be careful not to touch or scratch the green drum surface.

WARNING!

If the printer has been powered on, the fuser area will be hot. 
This area is clearly marked. Do not touch it.

CAUTION!

Never expose the image drum unit to light for more than 5 
minutes. Never expose the image drum unit to direct sunlight. 
Always hold the image drum unit by the ends or from the top. 
Never touch the surface of the green drum inside the image 
drum unit.
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4. Remove any jammed sheets from the paper path.

5. Re-install the image drum complete with toner cartridge, ensuring that the pegs 
(1 & 2) correctly locate into the slots on each side of the printer (3). 

6. Lower the top cover but do not press down to latch it closed yet. This will protect 
the drum from excessive exposure to room lighting, while you check the 
remaining area for jammed sheets.

3
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7. Open the rear cover and check for paper in the rear path. Pull out any paper 
found in this area.

• If the paper is low down in this area and difficult to remove, it is probably still 
gripped by the fuser. In this case, raise the top cover, reach around and press 
down on the fuser pressure release lever.

• If you are not using the rear cover, close it once the paper is removed from 
this area.

8. Remove the Duplex unit (1) and check for any paper in this area. Remove any 
paper and replace the duplex unit.

1
2
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• If the paper is difficult to remove, push the duplexer cover in the direction of 
the arrow on the top, then raise the cover and remove the paper.

9. Open the Multi Purpose Tray (1) and remove any paper that you find (2). 

10. Close the tray.

11. Close the top cover and press down to latch it closed.

12. The printer will warm up and commence printing when ready. The page lost 
through the jam will normally be reprinted.

Note
If the edge of the jammed paper protrudes (or can be seen) from the exit, 
reinstall the image drum, close the top cover and switch the printer on. 
Remove the jammed paper from the exit when the exit roller begins 
rotating after a few seconds after switching on. However, if the jammed 
paper cannot be removed, contact a service representative.

1
2
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PRINT QUALITY PROBLEMS

Before consulting a service representative regarding a print quality problem, check the 
table below to see if there is a solution, or something you might have overlooked.

SYMPTOM PROBLEM SOLUTION

Blank sheets 
printed.

Image drum cartridge not 
properly installed.

Reinstall image drum cartridge.

Empty or missing toner 
cartridge.

Install new toner cartridge.

Entire page prints 
faintly.

Empty toner cartridge. Pages 
get fainter when toner is used 
up.

Install new toner cartridge.

LED array is dirty. Clean LED array.

Page has grey 
background.

Static electricity, generally 
from dry environments, 
causes toner to stick to 
background.

Change paper to a smoother laser 
bond or use a humidifier.

Page prints all 
black.

Hardware problem. Contact service.

Page has 
repetitive marks.

Damaged image drum 
cartridge causes repetitive 
marks every 1.6 inches (4.06 
cm) due to surface nicks and 
scratches.

Generate a cleaning page, repetitive 
marks may be temporary.

Oblong area of 
faint print 
appears on each 
page.

Drop out caused by using 
paper exposed to high 
humidity.

Change paper stocks, check paper 
storage environment or use a 
dehumidifier; check toner level.

Vertical white 
streaking or faint 
areas on page.

Toner is low and does not 
distribute properly, or the 
drum is worn out.

Replace toner cartridge. Check drum 
and replace the drum, if necessary. 
Contact service.

LED array is dirty. Clean LED array.

Vertical black 
lines.

Hardware problem. Contact service.

Fuzzy print. LED array is dirty. Clean LED array.

Distorted print. Paper path, lamp assembly, 
or fusing unit problem.

Generate cleaning page.

Contact service.

Faded print. Toner cartridge is not 
correctly installed.

Toner low.

Install toner cartridge correctly.

Replace toner cartridge.

Smeared or 
blotched print.

Dirty rollers; toner dropped 
inside printer or image drum 
problem.

Replace image drum and toner.

Contact service.

Printed page is 
light/blurred.

Is toner low? Replace toner cartridge.

Is paper meant for laser 
printers?

Use recommended paper.

LED array is dirty. Clean LED array.
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PAPER FEED PROBLEMS

Bold characters 
and dark lines are 
smeared.

Toner is low. Install new toner cartridge.

Print is darker 
than usual.

Darkness setting is too high. Change darkness setting.

Pages curl 
excessively.

Printing on wrong side of 
paper.

Turn paper over in tray. (Note arrow 
on paper package). Install paper 
print side down in tray.

Moisture in paper. Improper 
storage.

Avoid storing paper in areas of 
excessive temperature and humidity. 
Store paper in protective wrapping.

High humidity. Recommended operating humidity: 
20-80%.

SYMPTOM PROBLEM SOLUTION

Paper Jams occur 
frequently. Multiple 
sheets of paper are fed at 
the same time. 

The printer is tilted. Place the paper on a 
stable and flat surface.

Paper is too thick or too 
thin. Paper is moist, 
folded, creased or 
warped. 

Use paper suitable for the 
printer. Avoid storing 
paper in areas of 
excessive temperature 
and humidity. Store 
paper in protective 
wrapping

Paper is not aligned. Align the paper edges to 
the paper guides.

Only one sheet of paper is 
loaded in the Paper tray 
or Multi Purpose tray.

Load several sheets of 
paper.

Sheets of paper is added 
to the existing paper 
stock in the Paper tray or 
Multi Purpose tray.

Remove existing sheets 
of paper from the tray 
and add the new sheets 
to them, ensuring 
alignment and then load 
the tray.

Postcards, envelopes, 
label sheets or 
transparencies are loaded 
in the Paper tray.

Postcards or envelopes 
are placed in the wrong 
orientation.

You cannot print using 
the Paper tray. Load 
postcards, envelopes, 
label sheets or 
transparencies in the 
Multi Purpose tray.

Check and load in the 
correct orientation.

SYMPTOM PROBLEM SOLUTION
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Paper is not fed into the 
printer.

Improper setting is 
selected for Paper 
Source in the printer 
driver.

Select the correct paper 
source from the Source 
drop down menu.

The printer menu setting 
is incorrect.

Set the size of the paper 
in the Setup Menu of the 
printer.

Printing does not resume 
after removing jammed 
paper.

Printing does not resume 
only by removing paper 
jam.

Open and close the top 
cover.

SYMPTOM PROBLEM SOLUTION
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SOFTWARE PROBLEMS

Your software (operating environment, applications and printer drivers) controls the 
printing process. Make sure you have selected the right driver for use with your printer. 
See your software documentation for more information.

HARDWARE PROBLEMS

SYMPTOM PROBLEM SOLUTION

Printing is 
garbled.

Incorrect driver is installed. Install an appropriate driver.

Printer’s output is 
below rated 
speed.

Much of the printing delays 
will be caused by your 
application. Sometimes 
purely text documents will 
print slowly depending on 
the selected fonts and how 
they are transferred to the 
printer.

For maximum speed, use text in 
your document and use a printer 
resident font.

Size of top margin 
increases with 
each page 
printed.

Creeping text. Number of 
lines per page in software is 
not equal to number of lines 
per page of printer.

Many software packages assume 66 
lines per page, but your printer’s 
default is 64. Adjust software 
accordingly, or set LINES Per PAGE 
in the soft control panel to equal 
lines per page in your software.

SYMPTOM PROBLEM SOLUTION

Graphic image 
prints partly on 
one page, partly 
on the next.

Insufficient printer memory 
for this image at this 
resolution.

Change the resolution, reduce the 
image size, or install more memory 
in your printer.

When you try to 
print nothing 
happens, but 
printer indicates it 
is ready to 
receive data.

Configuration error. Check cable connection. If more than 
one printer is available, make sure 
your printer has been selected.

Garbage prints. Incorrect cable configuration. 
Also, see Software Problems.

Check cable configuration, 
continuity, and length.

Printer freezes or 
displays error 
message when 
computer is 
rebooted.

Booting the computer while 
the printer is on can cause a 
communications error.

Turn printer off before rebooting 
computer.

Odors. Gases are given off by forms 
or adhesives passing through 
the hot fusing unit.

Make sure the forms you use can 
withstand heating, and provide 
adequate ventilation.

Printer is on but 
must warm up 
before a job is 
printed.

Power Save mode is set on to 
conserve energy. The fuser 
must heat up before you can 
begin printing the next job.

To eliminate warm up delay, change 
Power Save setting.
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Options
The following options are available to extend the performance of your printer:

• 128 and 256MB RAM DIMM: to extend the main memory of your printer and speed 
up the processing of large files

• Second paper tray: to increase your printer’s paper handling capacity by 530 sheets 
(75g/m²)

OPTIONS ORDER NUMBERS

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation sheet that 
accompanies the option.

128 MB RAM DIMM 44029501

256 MB RAM DIMM 44029508

SECOND PAPER TRAY (TAN) 43990701



Specifications 
ITEM SPECIFICATION

Dimensions, 
W x D x H

14.5 x 15.5 x 10,5 inches (369 x 395 x 268 mm)

Weight 22.7 lb (10.3 kg) approximately (without second tray)

Printing method Electro-photographic printing using LEDs as light source

Print color Monochrome

Print speed Letter: 30 pages per minute maximum

A4: 28 pages per minute maximum

Resolution 2400 x 600 dots per inch

Operating 
platform

Windows
2000/XP/XP server 2003 x 64 bit edition/Vista/Vista x 64 bit 
edition

Mac

OS X PowerPC (10.2.8 - 10.5) / OS X Intel (10.4.4 - 10.5)

Emulations PCL5e, PCLXL, Epson FX, IBM ProPrinter

Interfaces Parallel port in compliance with IEEE 1284-1994 standard

USB 2.0 High speed 

Ethernet: 100BASE-TX/10Base-T

Processor 297 MHz PowerPC

Memory 64MB expandible to 320MB

Printer/Fuser life 200,000 pages or 5 years

Toner life Starter: 1,500 pages

Replacement: (ISO/IEC19752)

up to 3,500 / 7,000 pages / 10,000 pages, depeneding on toner 
cartridge installed

Image drum life Simplex printing

25,000 pages (continuous)
20,000 pages (3 pages per job)
12,000 pages (1 page per job)

Duplex printing

15,000 pages (continuous)
13,000 pages (3 pages per job)
10,000 pages (1 page per job)

Paper sizes Letter, Legal 13, Legal 14, Executive, A4, A5, A6, B5, Custom, 
C5, C6, Com-9,Com-10, DL, Monarch, Statement

Paper feed Automatic feeding via paper trays (including optional second 
tray and Multi Purpose Tray)

Paper feed 
capacity
at 20-lb. US 
Bond (75 g/m²)

Tray 1: 530 sheets

Optional Tray 2: 530 sheets

Multi Purpose Tray: 50 sheets 

Paper output Face up, using rear (straight through) exit path

Face down, using top exit path
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Power 
consumption  at 
72°F (22°C)

Typical: 450W

Idle: 70W

Power save mode: 7W

Paper output 
capacity at 
20-lb. US Bond 
(75 g/m²)

Face down  (top exit): 150 sheets

Monthly duty 
cycle

70,000 pages

Consumables Toner cartridge, Image drum

Power cable Approximately 6 ft. (1.8 m) max. length

Noise level Operation: 53 dB(A) 

Standby mode: 30dB(A)

Power saving mode: Background level

Environmental 
conditions

Operation: 50 to 90°F (10 - 32°C), 20% - 80% RH, 

Storage: 50 to 109°F (10-43°C), 10% - 90% RH

When the printer is stored, it should be in its original 
packaging, with no moisture formation.

ITEM SPECIFICATION
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Paper and tray information
 

 

Simplex Printing

Feed
Tray

Exit Path

Paper type Size Weight T1 T2 MPT Top Rea
r

Plain paper Letter, A4 L, ML, M, MH 0 0 0 0 0

A5, B5,

Executive

L, ML, M, MH, H 0 0 0 0 0

Legal (13)

Legal (14)

H 0 0 0 0 0

Statement L, ML, M, MH, H 0 X 0 0 0

A6 L, ML, M, MH, H X X 0 0 0

Custom L, ML, M, MH 0 0 0

W: 90 – 216
L: 148 – 356

H 0 0 0

Postcards - X X 0 0 X

Envelopes Com-9

Com-10

DL, C5, C6

Monarch

Custom
W: 90 - 216
L: 148 - 356

- X X 0 0 X

Labels Letter, A4 - X X 0 0 X

Transparencies Letter, A4 - X X 0 0 X

SYMBOL/TERM MEANING

MPT Multi Purpose Tray 

W, L Width, Length in mm

L Light paper weight: 64g/m2

ML Medium Light paper weight: 64 - 74g/m2

M Medium paper weight: 75 - 87g/m2

MH Medium Heavy paper weight: 88 - 104g/m2

H Heavy paper weight: 105 - 120g/m2

0 Can be used

X Cannot be used

Can be used depending on the size.
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Duplex Printing

Auto Manual

Paper 
type

Size Weight Tray 
1

Tray 
2

MPT Tray 
1

Tray 
2

MPT

Plain 
paper

Letter, A4 L, ML, M, 
MH

0 0 0 0 0 0

Legal (13)

Legal (14)

H X X X 0 0 0

A5, B5, 
Executive

L, ML, M, 
MH, H

X X X 0 0 0

Statement L, ML, M, 
MH, H

X X X 0 X 0

A6 L, ML, M, 
MH, H

X X X X X 0

Custom L, ML, M, 
MH

0

W: 90 - 216
L: 148 - 356

H X X X 0

Postcards - X X X X X X

Envelopes Com-9

Com-10

DL, C5, C6

Monarch

Custom
W: 90 – 216
L: 148 – 356

- X X X X X X

Labels Letter, A4 - X X X X X X

Transpa-
rencies

Letter, A4 - X X X X X X

SYMBOL/TERM MEANING

MPT Multi Purpose Tray 

W, L Width, Length in mm

L Light paper weight: 64g/m2

ML Medium Light paper weight: 64 - 74g/m2

M Medium paper weight: 75 - 87g/m2

MH Medium Heavy paper weight: 88 - 104g/m2

H Heavy paper weight: 105 - 120g/m2

0 Can be used

X Cannot be used

Can be used depending on the size.
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NOTES

1. Tray 1 can accommodate paper with width of 100 to 216mm and length of 210 to 
316mm.

2. Tray 2 (optional) can accommodate paper with width of 148 to 216mm and 
length of 210 to 316mm.

3. When printing using Auto Duplex, paper will not be ejected face up.

4. The printing speed is reduced when you set the paper size of A5, A6, Postcards, 
Envelopes as Heavy.

5. Label mode must be selected in the printer driver, if you want to print on heavy 
media which exceeds 120g/m2.
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Service and Support
Available 24 hours a day, 7 days a week

• Visit our multilingual web site: www.okiprintingsolutions.com

• Call 1-800-654-3282
Service and Support > 74
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